Table of Contents

Motherboard Screensaver 3
Psalm Poster 8
Pre-Press Guide 15
Typographic Posters 30
Buchwald Tour Guide 39
Children’s Book 46
Fictional Book Jacket 68
Autobiography Book Jacket 73
Personal Branding 80
Packaging Design 86
Cause Posters 95

Infographic 107



Motherboard Screensaver

Software: Adobe lllustrator
Size: 1920 x 1080 px

Create a screensaver that represents the Motherboard Helpdesk at MVNU. This
screensaver should represent the service and should be aesthetically pleasing.
This screensaver will be displayed on computers all around campus.

For this Motherboard screensaver, a simple design was created that illustrates

the essence of Motherboard, using a circuit board and the MVNU flame logo as

a few of the circles on the ends of the circuits, creating a motif that merges the
Motherboard Helpdesk’s technological background and purpose on the campus
with the branding of the university. MVNU's branding colors were also included so
as to make the branding cohesive and complete and make viewers connect the
school and their IT department.
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Psalm Poster

Software: Adobe lllustrator and InDesign
Size: 13 x 19 1in

Design a poster representing either Psalm 150 or Psalm 23 in the style of a famous
and influential graphic design.

This poster was designed in the style of Paula Scher and her Public Theater “Bring
in ‘da Noise, Bring in ‘da Funk” poster. Bright colors, vivid, expressive, and bold
type, and the incorporation of black and white photography are all present in
Paula’s work as well as this poster. The spirit of Psalm 150 as well as Paula’s is
captured in the vivid yellow, which contrasts with the bold type and red accents.
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Pre-Press Guide

Software: Adobe InDesign, lllustrator
Size: 4 x 6 in

Create a guide to explain the pre-print, production, and post-print processes.

Flashcards are an easy way to learn and retain information, and they are a familiar
medium of study, which is why they were chosen for this press guide. These
flashcards go through every aspect of the printing process, and can easily be
accessed or placed on a desk. Each section of the printing process is color-coded
using the CMYK color scheme, and the information is illustrated through both
images and text explanations and definitions in an easy to understand manner.
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Trapping
Spread -

¢ lighter object overlaps a darker
object, so the lighter object seems to
expand into the background.

Choke -

¢ a lighter background overlaps
a darker object that seems to fall
within the background, reducing
and containing the object.



Final Design

QUICK TIPS

* Begin with the end in mind. Make sure you
give yourself enough time to complete your
project and get it printed by the deadline.

* Make sure to package your files! You can
do this by going to File > Package in Adobe
InDesign. This ensures all your images and

PRINTING GUIDE

* Be sure to change your images to CMYK in
Photoshop for print projects. Go to Image >
Mode > CMYK.

* Use this guide to better prepare your
document for print, and use it to brush up on
your knowledge of the Pre-Press, Production,
and Post-Press processes in printing!

DOCUMENT SETUP DOCUMENT SETUP

Bleeds -

* space around the layout that extends past the
edges of the page. If something such as color is
going beyond the edge, bleeds are crucial, but
they should always be used.

Bleed marks

HOW TO: BLEEDS

Document setup >

Bleed & Slug >

enter desired amount of bleed (.25
is standard)




DOCUMENT SETUP I DOCUMENT SETUP I

Margins -

* images/elements you do not want to get cut
off should remain within the margin arcas.

/M“M“s
T

HOW TO: MARGINS

New document > margins > set desired
margin areas. Margins ar already set
at.5”, but you can adjust them as you'd
like.

DOCUMENT SETUP I DOCUMENT SETUP I

Crop Marks -

| | ¢ Guidelines that show where the paper should
I [ be cut.

|
T Q Crop marks

HOW TO: CROP MARKS

InDesign: File > Export >
| | PDF > Marks & Bleeds > check the
T I crop marks option

Tlustrator: Click on the object you
wish t0 add crop marks to, then go to
Effects > Crop marks




DOCUMENT SETUP I DOCUMENT SETUP I

PDF -

* Most printers prefer PDF files with bleed and
crop marks.
* PDF files can be viewed without software and

‘xr] iCh fi‘le t}TpeS can easily be viewed, printed, and sent.
are accepted by
. 9 Adobe -
prlnters . * Adobe is the standard.

* Most printers accept Illustrator, InDesign, and
Photoshop files. These are the most common and
accepted digital formats.

Do notsend Word documents!

DOCUMENT SETUP I DOCUMENT SETUP I

Imposition -

* layout of pages so they can be bound in the
1 proper order.
* Through this, you design based on how the
pages will be printed rather than read.

front back
cover cover

HOW TO: IMPOSITION

Make sure to design pages 1 and 8 on
the same spread, 2 and 7 on the same
spread. and so on.
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w
e T T




COLOR & INK ' COLOR & INK '

CMYK -

 Cyan, Magenta, Yellow, Black

* Print documents should almost always be in
CMYK for four color printing

* Print designs are comprised of these 4 inks
 Also known as process colors

COLOR & INK ' COLOR & INK '

RGB -

*Red, Green, Blue

* Do notuse for print materials.

* Used for on-screen materials (web)

 These three colors can be combined to ereate
any color on the visual spectrum.
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COLOR & INK COLOR & INK '

Spot Color -

* “solid” colors

* Created by an ink, pure or mixed

that is printed on a single print run

* Spot colors can be Pantone, metallic, or

2291C * During the printing process, a separate plate
must be created for a spot color.

¢ Creates a mor ¢ color than CMYK
based on the colors you see on screen.

Pantonc colors
2412U

109C 151C

COLOR & INK ' COLOR & INK '

Rich Black -

* Solid black over one or more process colors
which creates a richer tone than just black ink.

Rich Black
C=60
M =40
Y-40
K =100
100% Black



COLOR & INK ' COLOR & INK '

Transparency -

* When the opacity of an object
is lessened

Transparency

COLOR & INK ' COLOR & INK '

Duotone -

* Ispotcolor with the
addition of black

Tritone -

* 2spotcolors with the
addition of black

What are tinted
grayscales?

Quadtone -

* 3 spotcolors with
the addition of black




PRODUCTION I

What are the two main
paper types?

PRODUCTION I

Coated -

Uncoated -

* Matte-coated - non-glossy finish
* Gloss-coated - smooth slightly reflective
finish. Colors appear richer and more vibrant

* Smoother and stronger than standard copy
paper, does not have a coating

PRODUCTION

PRODUCTION

Offset Printing -

« image is burned onto a plate, transferred to
rubber “blanket’, then transferred to printing:
surface. Repulsion of oil and water; plates have
areas receptive to grease and areas receptive to
water, those receptive to grease hold the ink. 4
different plates for the 4 different CMYK colors.

PRINTING METHODS

Digital - Utilizes toner and liquid ink
and docsn’t use plates. Works well for
small print runs. This Includes laser
and inkjet printing.

Screen- When ink or metal is forced
onto a surface through a fine screen to
creatca

desired pattern.
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Spread -

* lighter object overlaps a darker object,
so the lighter object seems to expand into the
background.

Spread vs.
Choke Choke -

* alighter background overlaps a darker
object that seems to fall within the background,
reducing and containing the object.

TRAPPING TRAPPING

Overprint -

*When one layer of ink is printing over

What iS 2::11(»:.11'1' layer. This might cause variations in
overprint?

N N




TRAPPING I

What is
knockout?

Vector vs.
Bitmap

e}

Knockout -

A portion of the bottom color is not printed.
This occurs when two colors overlap.

T 0
o B
o

Vector -

* Vectors use geometric formulas to represent
images, therefore can be sized as big as desired
without becoming pixelated.

Bitmap -

* Bitmap images are comprised of pixels, a
bunch of small dots. If the image is enlarged, the
pixels will show and the image will become of

lesser quality where the individual pixels will

VECTOR BITMAP

| HAVE SHARP EDGES \AMFUZZY  fmagefrom: Superluze
Sereen Printing
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Standard DPI1

FINISHING

What is

embossing?

Gsommors L

DPI-

* Dots per inch. There are also pixels per inch
(PPI). This is the resolution of your image.
Standard DPI is 300. Make sure your image
resolution is as high as possible to ensure the
crispest image.

300DPI

FINISHING

Embossing -
¢ Pressing an image into paper to create a raised

effect

Photo credii: Village Print & Media




FINISHING

UV Coating/Spot
Varnish

FINISHING

UV Coating -
¢ Glossy liquid coating applied to paper using
an ultraviolet light. Protects the material from
harmful effects

Spot Varnish -

* Varnish only applied to parts of a printed
paper

Photo credit: Elbags

Saddle Stitching -

* Wire is punched through spine, and then the
wire is bent flat on the inside center fold.

* This is the most common/

cheapest method

Wire




Perfect Bound -

s are glued to wrap-around cover,
scored on the front and back to prevent
stress on the spine.

Spiral/Coil Bound -

* Smooth, round coil holds pages together,
allowing the book to lie flat when it is open.

Coil




Typographic Posters

Software: Adobe InDesign
Size: 11 x 17

Create a poster series depicting 3 typefaces from 3 different eras.

The history of typefaces are usually not known, even to designers. These posters
were created to inform the viewer about 3 different typefaces, all present in 3
different eras of design. Each poster utilizes the style of design from the era

in which the typeface was created. For Garamond, a strong use of decoration
was used to represent the ornamental design style of the 1500s. For Palatino,
elements of the International Typographic Style were incorporated. And finally,
for the Avenir poster, strong echoes of postmodern design are present. A
sophisticated plum color is utilized along with black and white to represent a
timelessness and design quality in each of these eras.
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The Garamond typeface was created by the French
des Claude Garamond in 1530. Garamon

2 punch cutter, type designer, publisher, and
founder. He was actually one of the first punch
cutters to work as an independent instead of a

printer. The typeface, named after himself,

considered a “typographical highlight of the 16th

century”. The font
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Hermann Zap

as created by
German Hermann Zapf in 1948. Zapf
is still one of the most highly regarded type
designers. He began his career in the graphic
arts at age 16 as an apprentice, and he began
designing type later on because of Edward
Johnston and Rudolf Koch (who he later worked
with). He had strong roots in call
the name of his typeface com
calligrapher named Giambatista P:
Palatino became a staple of the International
ographic Style. It was originally created
as a punch cut, but was soon adapted for the
linotype machine. It is a roman style face that
contains strong serifs and readable letters. That

[ ]
readability can be contributed to the openn
of the letterforms.In a time where the Bauhaus
nd constructivism had paved the mple.
objective, readable des: were extremely

important to designers as well as those
looked to design as a form of communication.

‘The Palatino typeface was created by German
Hermann Zapf in 1948, Zapf s still one of the most
highly regarded type designers. He began his career
in the graphic arts at age 16 as an apprentice, and
he began designing type later on because of Edward
Johnston and Rudolf Koch (who he later worked with).

He had strong roots in calligraphy, and the name of

o talianc. n

Giambattista Palatino. Palatino became a staple of
the International Typographic Style. It was originally
created as a punch cut, but was soon adapted for the
linotype machine. Itis a roman style face that contains
strong serifs and readable letters. That readability can
be contributed to the openness of the letterforms.In
a time where the Bauhaus and constructivism had
paved the way, simple, objective, readable designs
were extremely important to designers as well as those
who looked to design as a form of communication.




ABCDEFGHIJKLM

NOPQRSTUVWXYZ
abcdefghijklmnop
gqrstuvwxyz!#@&?

Roman
ABCDEFGHIJKLMN

cdefghijklmnopgqrs

OPQRSTUVWXYZab
tuvwxyz!#@&?

Bold
ABCDEFGHIJKLMN

OPQRSTUVWXYZa

bcdefghijklmnopq
rstuvwxyz!#@&?




Final Design

GARAMOND

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz! @& %#

The Garamond typeface was created by the French
designer Claude Garamond in 1530. Garamond was
a punch cutter, type designer, publisher, and type
founder. He was actually one of the first punch
cutters to work as an independent instead of a printer.
The typeface, named after himself, was considered 2
“typographical highlight of the 16th century.” The
font was created for King Francis I and was first used
as the type in books by Robert Estienne. Garamond
was the first instance of type going beyond that

of handwritten styles. Not much is known about

the typeface’s past, as most of what we know of

Garamond today are refined and edited versions,
such as Adobe Garamond Pro, However, the typeface
still leaves a legacy and is still widely used today. The
readability of the font makes it a popular choice for
body copy. The letterforms of Garamond are thinner
than other fonts created before it, and so it was a
very innovative typeface design. Garamond features
medium contrast between line weights and very open
counters (openings in letters). Today, Garamond is
available in Regular, Bold, and Itali.

1530



PALATINO

Created by German designer Hermann Zapf in
1948, Palatino is regarded as one of the most
important typefaces of its era. Zapf is still one
of the most highly regarded type designers. He
began his career in the graphic arts at age 16 as
an apprentice, and he began designing type later
on because of Edward Johnston and Rudolf Koch
(with whom he later worked). He had strong
roots in calligraphy, and the name of his typeface
comes from an Italian calligrapher named
Giambattista Palatino. Palatino became a staple
of the International Typographic Style. It was
originally created as a punch cut, but was soon
adapted for the linotype machine. It is a roman
style face that contains strong serifs and readable
letters. That readability can be contributed to
the openness of the letterforms. In a time where
the Bauhaus and constructivism had paved the
way, simple, objective, readable designs were
extremely important to designers as well as those
wholooked to design as a form of communication.

1948







Buchwald Tour Guide

Software: Adobe InDesign
Size: 10 x 15 in

Create a tour guide for prospective students and parents who are visiting
Buchwald. The tour should be able to be self-guided.

The goal of this project was to create a self-tour guide for the Buchwald Center.
Oftentimes, MVNU admissions counselors don’t have time to get downtown,

so it's important for prospective art and design students to be able to visit the
state-of-the-art facilities available. For this guide, the map is the main focal point
and uses the bright MVNU branding colors and an easy to navigate key to help
potential students, parents, and other visitors find their way around the building.
The brochure utilizes a roll fold so that as it is unfolded, each floor is revealed so
as to not overwhelm the viewer. On the outside, information about the Buchwald
Center is offered, along with highlights of key locations within the building and
with high-contrast photographs.
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HAPPY BEAN

Need a break from creating, or just need a spor
0 do homework and drink a hot cup of coffec?
Right next door to Buchwald is Hunter Hall,
MVNU's nursing building. Inside is Happy
Bean, a popular coffce shop among both locals
and students. Happy Bean also takes Road
Bucks,  form of money that can be used

at the 586 on campus as well. Happy Bean
offers coffce and non-coffce oprions, as well as
pastries. Is a great place to get work done or
hang out with friends!

Hours: 7 AM — 7 PM Mon — Fri
9 AM - 5 PM Saturday
Closed Sunday

BASEMENT

[T] ceramics

In the ceramics studio, students learn the

fundamentals of pottery. There i a kiln
and a glaze room in the studio.

PRINTMAKING

Students learn different types of
printmaking and are able to experiment
with each.

GALLERY

“The Schnormeier Gallery is located at the very
front of the building. The senior fine ars and
graphic design students use the space for their
senior exhibitions, allowing for a professional
stting to prepare them for their carcersin the
ares and in design. The gallery holds recepions
for every show as well as artist alks.

Gallery Hours: 1 — 5 PM Mon — Fri
Contact: (740) 392-6868

Instagram: @schnormeicrgallery
Facebook: Schnormeicr Gallery

FIRST FLOOR

SCHNORMEIER GALLERY
MAC LA

The Mac Lab is where all graphic design
courses take place.

CLASSROOM
This clasroom is used for various lecture
clases such as History of Graphic Design

[ RESTROOMS

ABOUT

Welcome!

Thank you for stopping by the Buchwald
Center. Here, you'll find state-of-the-art
facilicies, a gallery which houses student,
alumni, and other artist exhibitions, a coffee.
shop just seconds away in Hunter Hall (the
aached building), and creative inspiration!

There are 64,000 square feet of speae to explore.

Students have been utilizing the state-of-the-arc
studios and gallery since 2009.

211S Main St
Mt Vernon, OH 43050

SECOND FLOOR THIRD FLOOR

Il WORKsHoP
The worishop s where woodworking
el and canis ki ks phc

] pARKROOM

[ SENIOR STUDIOS
Senior art students work here.
[ MATTING RoOM

Project prep/mounting,

[ DESIGN STUDIO

Fundamental classes like Color
‘Theory and Design Foundations are
held here.

[ RESTROOMS

[ PAINTING STUDIO

[] DRAWING ROOM

[ ResTROOMS




HAPPY BEAN

Need a break from creating, or just need a spot
t0 do homework and drink a hot cup of coffec?
Right next door to Buchwald is Huner Hall,
MVNUSs nursing building. Inside is Happy
Bean, a popular coffee shop among both locals
and students. Happy Bean also takes Road
Bucks, a form of money that can be used.

at the 586 on campus as well. Happy Bean
offers coffee and non-coffee options, as well as
pastries. I¢s a great place to get work done or
hang out with friends!

Hours: 7 AM — 7 PM Mon — Fri
9 AM — 5 PM Saturday
Closed Sunday

BASEMENT

At rerovita quam andiae omniet omnihic tem
quam sae est essunt landit, omnist molum quame
offic te et volum dolupta asse oditis aliquas es delis
ullaturera jus quiationsedi dis cat

Pocket with photos

Floor Plan

GALLERY

‘The Schnormeier Gallery is located at the very
front of the building. The senior fine arts and
graphic design students use the space for their
senior exhibitions, allowing for a professional
setting to prepare them for their carcers in the
arts and in design. The gallery holds receptions
for every show as well as artist talks.

Gallery Hours: 1 — 5 PM Mon — Fri
Contact: (740) 392-6868

Instagram: @schnormeicrgallery
chnormeier Gallery

FIRST FLOOR

Pocket with photos

ABOUT

Welcome!

‘Thank you for stopping by the Buchwald
Center. Here, you'll find state-of-the-art
facilities, a gallery which houses student,
alumni, and other artist exhibitions, a coffee
shop just seconds away in Hunter Hall (the
atached building), and creative inspiration!
There are 64,000 square feet of spcae to explore.
Students have been utilizing the state-of-the-art
studios and gallery since 2009.

| - — |
BUCHWALD

2118 Main St
Mt Vernon, OH 43050
(740) 397-0701

SECOND FLOOR THIRD FLOOR

At rerovita quam andiac omnict omnihic tem
quam sac est essunt landit, omnist molum quame

offic te et volum dolupta asse oditis aliquas es delis
ullacurera ius quiationsedi dis at

Floor Plan

Floor Plan

At rerovita quam andiac omniet omnihic tem
quam sac st essunt landit, omnist molum quame
offic te et volum dolupta asse oditis aliquas es delis
ullarurera fus quiationsedi dis ca

Pocket with photos

Floor Plan

Pocket with photos.

At rerovita quam andiae omniet omnihic tem
quam sac est cssunt landit, omnist molum quame
offic te et volum dolupea asse oditis aliquas es delis
ullaturera ius quiationsedi dis cat
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‘The Mac Lab is where all graphic design classes
take place. The room is equipped with Mac desktop
computets and an Epson color printer.

tools for wordworking, Many students use the workshop
to make canvases for their painting classes.

The Painting Studio is a spacious area for students to
work on paintings.

WELCOME!

‘Thank you for stopping by the Buchwald Center.
Here, you'll find state-of-the-art facilities, a
gallery which houses student, alumni, and other
artist exhibitions, a coffee shop just seconds

away in Hunter Hall (the attached building),
and creative inspiration! Feel free to explore the
64,000 square feet available to students. Students
have been utilizing the state-of-the-art studios
and gallery since 2009.

In the Ceramics Studio, students learn the fundamentals
of pottery. There is a kiln and a glaze room in the studio.

|
‘The Schnormeier Gallery hosts student, alumni, and
other artist shows. Hours are 1 — 5 Monday through
Friday. Receptions and artist talks are held regularly, and
senior graphic design and art exhibitions are held here.
(Pictured: 2018 Senior Graphic Design Exhibition in
Schnormeier Gallery)

BUCH
WALD

ART & DESIGN
DEPARTMENT

211 South Main Street
Mount Vernon, OH 43050

MOUNT @ VERNON

NAZARENE UNIVERSITY
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Children’s Book

Software: Adobe lllustrator
Size: 8 x 8 in

Create a book for from ages 2-3 or 4-5 with only four colors, one typeface,
and an engaging story for the children of that age group.

The goal of this assignment was to create a children’s book geared
towards children ages 4 — 5 as well as to their parent, teacher, or any adult
who is reading the book to that child. Often, adults have a hard time
finding stories that keep children engaged but also teach them a lesson.
Frosty Friends teaches children about sharing, a lesson that a young child
is able to engage in. The text is easy to read and not too detailed as to
make it easy for the child to understand, in a playful typeface. The book
is comprised of 8-10 pages of full color illustrations. A vivid color palette
that primarily consists of blues is used.
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Sam is a very sad snowman. His human friends had to say
goodbye. Now he has no nose, no arms, no hat, and no scarf!




Bethany the Bunny hops by. She

notices that Sam doesn't have a nose.

Bethany the B
un,
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She offers him her carrot. He thanks her for his nose.

She offers him her carrot. He thanks her for his nose. He's
a little closer to being ready for the party!







Chris the Cardinal flies by, carrying branches
in his mouth. He notices Sam doesn’t have any arms!

Suddenly, Benny the Bird flies by carrying branches.
He notices Sam doesn’t have arms!







He is a little less sad. but he still has no hat and no scarf! He's a little less sad, but still very cold!
Suddenly, Dom the Deer scampers by with a scarf! Suddenly, Dom the Deer scampers by wearing
He notices Sam shivering.




Finally, he justeedsa ha. Marty he Mouse Crawls by.
He’s wearing ahat!

Finally, he just needs a hat!
Marty the Mouse is walking by and ——
offers him the tophat he's wearing.




Both Marty and Dom offer Sam their accessories. He thanks
them for his hat and scarf.

Marty's hat was too small for Sam, but he loves it
just the same. He's finally ready for the party!




Sam, Bethany, Benny, Dom, and Marty dll enjoyed
the forestparty and played together! Sam is finally happy.

Now he is a complete snowman!
He thanks his new friends and asks if they want to play.




Final Design
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Sam is a very sad snowman.

His human friends had to say goodbye,
and they've left him plain and cold!

Now he's not dressed for the winter party.

Bethany the Buy,

She offers h

Y A
im o Ws
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“Will you be okay without it?”" Sam asks.
Suddenly. Benny the Bird flies by carrying branches.

“Of coursel” Bethany replies. He notices Sam doesn’t have arms, and he offers
“I have two, I'd love to share with you.” him the branches.




*Of course!” Benny replies.
“There are plenty of trees,
I'd love to share with you.”




Dom the Deer scampers by wearing a scarf.
He offers it to him.

[ JN
[

H%J\\

“Will you be okay without it?” Sam asks.
“Of course!” Dom replies.

*I have fur to keep me warm,
I'd love to share with you.”

Finally, he just needs a hat!
Marty the Mouse is walking by and
offers him the tophat he's wearing.




*Will you be okay without your hat?” Sam asks.

2

L I
[N

Lol 11

“Of course!” Marty replies.
*I have a warm home to go back to,
I'd love to share with you.”

“Thank you dll for sharing with me!” Sam exclaims.
He can finally smile again.

2

~O




Fiction Book Jacket

Software: Adobe InDesign, Lightroom
Size: 9x 21 in

Create a book jacket for a fictional novel.

Oftentimes, people do judge books by their covers. This book jacket was created
for a fictional young adult horror novel. Original photography stands as the back-
ground, the content of the image (an old, run-down building), able to be seen

but barely, giving a mysterious and ominous feeling that viewers can go into the
story expecting. An expressive, red, hand-scrawled typeface also brings a sense of
fear; red can often be associated with blood, especially in the horror genre. The
hand-scrawled type is reminiscent of nails on a chalkboard or chicken scratch on
the wall of a cave or abandoned building. When a viewer looks at this jacket, they
should be sparked with an uncertainty and an uneasy feeling.
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Jillian Vance was born and raised in

Mount Vernon, Ohio, and is currently

a senior at Mount Vernon Nazarene

University majoring in graphic deisgn
and minoring in markefing.

She has always loved reading and
watching horror, thus this novel was
born.

Jillian plans to move to Columbus
after graduation to pursue graphic
design further by either working for a
company or as a freelance designer.

was born and
raised in Mount Vernon, Ohio,
and is currently a senior at
Mount Vernon Nazarene U
versity majoring in graphic deis-
gn and minoring in marketing.

She has always loved reading
and watching horror, thus this
horrifying novel was born.

Jillian plans to move to
Columbus after graduation
to pursue design further by

working as a freelance graphic
designer.

THE DARK HOLDY $ECRETS
MORE TERRIFYING THAN yO
GREATEST YEARS,

“A horror masterpiece with a
diverse cast of characters.”

ng story that plays on the real-
life fears and demons we often face.”

“A win for horror fans of all
backgrounds. This story is truly
horrifying, you won't be disappointed.”

US $17.99 | CAN $19.99

“A horror masterpiece with a
iverse cast of characters.”
- THE NEW YORK TIMES

“Terrifying story that plays on the real-life
fears and demons we often face.”
- STEPHEN KING

“This story is truly horrifying, you won’t
be disappointed, and you definitely
won't be sleeping.”

- ASSOCIATED PRESS

US $17.99 | CAN $19.99

“A stunning horror story that rattles your bones and ferrifies your soul.”

\}uit«u VANCE

yOL NEVER KNOW WHAT™S NSIDE,

JiLLiAv vAvicE

Five fiercely different friends;
Leann, Alejandra, Heather, Burke,
and Danielle, all have one thing
in common. They want o know
what lurks inside the walls of the
abandoned Rolling Hills Hospital
for the Insane. When Heather
suggests urban exploration during
a boring weekend, the five make
their journey to the abandoned
asylum. Once they break in, they
realize the horrors lurking on the
inside are scarier than their worst
nightmares, and they might even
discover some disturbing secrets
about themselves - and each other.

BEWARE THE

Five fiercely different friends;
Leann, Alejandra, Heather, Burke,
and Danielle, all have one thing
in common. They want fo know
what lurks inside the walls of the
abandoned Rolling Hills Hospital for
the Insane. When Heather suggests
urban exploration during  bering
weekend, the five make their journey
to the abandoned asylum. However,
the horrors lurking inside are scarier
than their worst nightmares, and
those horrors might just bring out the
worst, and darkest, of each of them.

BEWARE THE
DARK,
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was born and
raised in Mount Vernon, Ohio, and
is currently a senior at Mount Vernon
Nazarene University majoring in
graphic design and minoring in
markefing, two of her passions.

She has always been a fan of horror,
and felt that too many

horror novels contain the same cookie-
cutter characters, so she decided

to write a novel with a diverse cast

of characters who break the typical
molds of the genre.

While she plans on moving to
Columbus to pursue graphic design
further, she hopes to work in the music
industry at some point in her career.

THE DARK HOLDS SECRETS MORE
TERRIFYiNG THAN yOUR GREATEST FEARS,

%
“A horror masterpiece with a diverse cast of characters.”

“Terrifying story that plays on the real-life fears and
demons we often face.”

“This story is truly horrifying, you won’t be disappointed,
and you definitely won't be sleeping.”

US $17.99. | CAN $19.99

®

PENGUIN
BOOKS

BEWARE THE SHADOWS e BEWARE THE DARK,

Five fiercely different friends; Leann,
Sasha, Heather, Burke, and Danielle,
all have one thing in common.; they
want to know what lurks inside the
walls of the abandoned Rolling Hills
Hospital for the Insane.

When Heather suggests urban
exploration during a boring
weekend, the five make their journey
to the abandoned asylum. However,
the horrors lurking inside are scarier
than their worst nightmares, and
those horrors might just bring out the
worst, and darkest, of each of them.




Autobiography Book Jacket

Software: Adobe InDesign
Size: 9x 21 in

Create a book jacket for an autobiography.

This book jacket was created for a memoir about life with Obsessive Compulsive
Disorder and anxiety. A calm, secure feeling is created with the muted color
scheme, which contrasts with the feeling of chaos often found within the mind
of a person with OCD, and also to represent the false security someone might
feel after completing their rituals attached to their triggers. Repetition is a heavy
theme within the cover because of thoughts and actions being repeated by
someone with Obsessive Compulsive Disorder. A handwritten typeface adds

a personal element to the jacket. An illustration of the designer’s silhouette is
utilized to represent the universality of mental illness and so viewers can also
relate the experiences detailed in the memoir to their own experiences with
OCD and anxiety.
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“A stunning memoir that takes readers into the
mind of someone suffering

from OCD. A gamechanger for those with the
disorder and other mental illnesses.”

-The New York Times

“Vance talks open and honestly about her struggles
and encourages readers to not be ashamed of
theirs. A beautiful read”

-Publisher’s Weekly

“This autobiography isn't just for those with
OCD.It’s for everyone.”

-Chicago Tribune
L2y a%a# to be scared o qpere up,

US $17.99 | CAN $19.99
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Jillian Vance &Z%

Jillian Vance was born and
raised in Mount Vernon, Ohio,
and is currently a senior

at Mount Vernon Nazarene
pursuing a Bachelor’s Degree
in graphic deisgn marketing.

Struggling with Obsessive
Compulsive Disorder as well
as anxiety, she wanted to shed
alight on mental health and
living a happy life despite the
dark days.

Jillian plans to move to
Columbus after graduation to
pursue graphic design further
by either working for a firm or
as a freelance graphic designer.

“A stunning memoir that takes readers into the
mind of someone suffering

from OCD. A gamechanger for those with the
disorder and other mental illnesses.”

~CHICAGD TRIBUNE

“Vance talks open and honestly about her struggles
and encourages readers to not be ashamed of
theirs. A beautiful read.”

~THE NEW YORY TIMES

“This autobiography isn’t just for those with
OCD. It’s for everyone who is struggling to accept

who they really are” -ASSOCIATED PRESS

“ITS 0KAY TO BE SCARED TO OPEN UP. BUT ONCE Y0U 20,
YOWLL rEEL LIBERATED. T PROMISE."

US $17.99 | CAN $19.99
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EVERY LITILE THOUGHT

VANCE

EVERY LITILE THOUGHT
COUNTS.

Tused to be scared to
talk about my Obsessive
Compulsive Disorder. I
didn’t want anyone to
know. I didn’t want anyone
to judge me because of my
mental fllness.

My mind is my own worst
enemy. However, my
mental illness doesn’t
define me. It doesn’t make
me less than anyone else.
T often wish I was normal,
that I didn’t have these
constant tics and rituals,
but God gave me this life,
and I have to learn to live
with my disorder.

THIS 1S MY STORY.




Jillian Vance was born and raised
in Mount Vernon, Ohio, and is
currently a senior at Mount
Vernon Nazarene pursuing a
Bachelor’s Degree in graphic
design and marketing

Struggling with Obsessive
ompulsive Disorder as well as
anxiety, she wanted to shed a
light on mental health and living a
happy life despite the dark days.

Jillian plans to move to Columbus
after graduation to pursue
graphic design further by

either working for a firm oras a
freelance graphic designer.

“A stunning memoir that takes readers into the mind of
someone suffering from OCD. A gamechanger for those
with the disorder and other mental illnesses”

-Chicago Tribune

“Vance talks open and honestly about her struggles
and encourages readers to not be ashamed of theirs. A
beautiful read”

-The New York Times

“This autobiography isn’t just for those with
OCD. It’s for everyone who is struggling to accept who
they really are, or struggling to accept others.”

-Associated Press

“IT'S 0KAY TO BE SCARED TO OPEN UP. BUT ONCE You
D0, YOU'LL FEEL LTBERATED. T PROMISE."

US $17.99 | CAN $19.99
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EVERY LITILE THOUGHT

JILLIAN VANCE

EVERY LITILE THOUGHT

counts.

Tused tobe scared to
talk about my Obsessive
Compulsive Disorder. I
didn’t want anyone to know
because I thought I would be
blacklisted from society.

My mind is my own worst
enemy. However, my mental
illness doesn't define me. It
doesn't make me less than
anyone else. I often wish I
was normal, I wish that I
didn't have these constant
tics, thoughts, and rituals, but
God gave me this life,and I
have to learn to live with my
disorder and do something
with it; make others feel less
alone. Let them know that it's
going to be okay.

This is my story.

ABOUT THE AUTHOR

Jillian Vance was born and raised
in Mount Vernon, Ohio, and is
currently a senior at Mount
Vernon Nazarene pursuing a
Bachelor’s Degree in graphic
design and marketing.

Struggling with Obsessive
Compulsive Disorder as well as
anxiety, she wanted to shed a
light on mental health and living a
happy life despite the dark days

Jillian plans to move to Columbus
after graduation to pursue
graphic design further by

either working for a firm oras a
freelance graphic designer.

PRATSE t0R £VERY LITIE THOYGHT

“A stunning memoir that takes readers into the mind of
someone suffering from OCD. A gamechanger for those
with the disorder and other mental illnesses”

-Chicago Tribune

“Vance talks open and honestly about her struggles
and encourages readers to not be ashamed of theirs. A
beautiful read.”

-The New York Times

“This autobiography isn't just for those with
OCD.It's for everyone who is struggling to accept who
they really are, or struggling to accept others.”

-Associated Press

US $17.99 | CAN $19.99
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EVERY LITILE THOUGHT

JILLIAN VANCE

EVERY LITILE THOUGHT
COUNTS.

Tused to be scared to

talk about my Obsessive
Compulsive Disorder. I
didn't want anyone to know
because I thought 1 would be
blacklisted from society.

My mind is my own worst
enemy. However, my mental
illness doesn't define me. It
doesn't make me less than
anyone else.1 often wish I
was normal, I wish that I
didn't have these constant
tics, thoughts, and rituals, but
God gave me this life,and 1
have tolearn to live with my
disorder and do something
with it; make others feel less
alone. Let them know that it's
going to be okay.

THIS 1S MY STORY.
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ABOUT THE AUTHOR

Jillian Vance was born and
raised in Mount Vernon, Ohio,
and is currently a senior at
Mount Vernon Nazarene
University majoring in graphic
design and minoring in
marketing, two of her passions.

Struggling with Obsessive
Compulsive Disorder as well as
anxiety, she wanted to shed a
light on mental health and living
ahappy life despite hardships.

‘While she plans on moving to
Columbus to pursue graphic
design further, she hopes to
work in the musicindustry at
some pointin her career.

PRATSE £OR. £UERY LITILE THOUGHT

“A stunning memoir that takes readers into the mind
of someone suffering from OCD. A game changer for
those with the disorder and other mental illnesses.”

— Chicago Tribune

“Vance talks open and honestly about her struggles
and encourages readers to not be ashamed of theirs.
Abeautiful read. I saw myself in each chapter.”

—John Green

“This autobiography isn't just for those with
OCD.It’s for everyone who is struggling to accept
who they really are, or struggling to accept others.”
— Associated Press

US $17.99 | CAN $19.99

I ISBN 9780430136365

PENGUIN
BOOKS 9! 780439 136365

TONUA Nprmie
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EVERY LITILE THOUGHT
COUNTS.

Living with OCD is not easy. At
times, my mind becomes my
own worst enemy, and it can be
difficult for me to even function.

However, my mental illness
doesn't define me. It doesn’t
make me less than anyone
else.Ioften wish I was normal,
that I could live life without the
struggles I face each day, but
God gave me this life,and I have
tolearn to live with my disorder
and do something with it; make
others feel less alone. Let them
know that it's going to be okay.

THIS 15 MY STORY.




Personal Branding

Software: Adobe lllustrator, InDesign
Size: Various sizes

Create personal branding for yourself including a logo, standards manual,
letterhead, and business card.

The focus of the Jillian Vance brand was creating a personal, warm feel for
clients while still maintaining sophistication and maturity. Jillian's signature

was chosen for a personal element, the organic, flowing shapes feeling much
more warm than hard-edged, geometric shapes. Cherry represents ambition,
confidence, and maturity. Midnight shows timelessness and sophistication, and
marshmallow represents cleanliness and purity. The Jillian Vance brand strives to
create timeless design in a signature style representative of the designer while
also solving problems and meeting the needs of clients. The brand remains
cohesive across platforms with a primary logo as well as a secondary logo to fit
the ratio of social media icons.
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(740)397-2888
jillian@jillianvance.com
jillianvance.design
jillianvance.design
g Jillian Vance Design




Packaging Design

Software: Adobe lllustrator, InDesign
Size: Various sizes

Create effective, intriguing packaging design for a food product, a beauty
product, or an electronic product.

This packaging design was created for a beauty subscription box.
The company and branding behind the box was also created by the
designer. six14society is a cosmetics brand that focuses on vegan
and cruelty-free products. The company also strives to provide

a cosmetics subscription box filled with vegan and cruelty-free
products, as other subscription boxes often don’t promise that
every product will be either cruelty-free or vegan. This subscription
box consists of 5 beauty products, all from six14society, tailored to
the subscriber’s “beauty profile” which outlines their complexion,
undertones, favorite shades, etc. and picks products to go along with
that profile. Each box comes to the subscriber’s door each month,
making beauty accessible and fun. The box is predominately black
with white and rose gold accents to represent sophistication and
trendiness. The brand is high-quality and medium-priced, which

is represented by the sophisticated design. This subscription box
contains a mascara, lipstick, highlighter, eyeshadow, and lip scrub.
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Cause Posters

Software: Adobe lllustrator, InDesign
Size: 11 x 17 in

Create a poster series promoting a cause or organization. This poster
series should educate, inform, or be a call-to-action.

Mental illness is looked at in a completely different way than physical
health, and is often a topic that becomes extremely stigmatized, resulting
in pain and misunderstanding for many. The cause and organization
chosen is Hope for the Day, a mental health awareness organization that
seeks to start the conversation on mental health by different outlets;
partnerships, advocates, and classes that help to destigmatize mental
illness and prevent suicide in a pro-active fashion. These posters stick
consistently to Hope for the Day’s branding colors (black and white), and
include bold text calling the viewer to learn more about mental health
and the stigma behind it, to help those in need, and to always have hope,
that they are never alone and always have resources. Pops of color call
attention to important information and key points about mental health.
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I
YOU HAVE THE POWER TO SAVE YQU HAVE THE POWER
L TO SAVE A LIFE.

In the United States alone, more
than 40,000 people are lost to
svicide each year, making it the
10th leading cause of death.Over
1.3 m

svicide each year.

-

Know the signs:

* Someone expressing feelings of being
trapped.

* Someone expressing hopelessness or
stating no reason for living.

* Someone withdrawing from family, their
friends, or usual activities they like.

* Someone talking or threatening to hurt
or kill themselves.

Note: these are not all of the signs someone struggling
may exhibit. Everyone deals with things differently. If you

sense something is wrong, please reach out and get help.

2 HOPE 7 DAY You could save a life.

IT’S OK NOT TO BE OK HFTD.ORG/GETEDUCATED




HAVE HOPE. YOUR STORY ISN'T
OVER YET. IT'S OK NOT TO BE OK. HAVEISI}I“O,TPEO.VYEORUYRE.?TORY

Over 44 million people suffer
from mental illness each year, so it is not
uncommon. Approximately 9.5% of
adults ages 18+ will experience a
depressive illness. However, only half of
Americans experiencing a major
depressive episode seek treatment.

Mental illness is nothing to be
ashamed of. Getting help is
nothing to be ashamed of.
There are plenty of resources:

Mental illness is nothing to be * The National Suicide

ashamed of. Getting help is Prevention Lifeline:
1-800-273-825

;ﬁfhmg to ble GShﬂfmed of. ) e Crisis Text Line: TEXT
ere are p enty Of resources: “ITSOK” TO 741741

¢ The National Suicide For more national and
Prevention Lifeline: international resources,
1-800-273-825 visit hftd.org

o Crisis Text Line: TEXT

“ITSOK” TO 741741 &
L HOPE =i DAY

For more national and &
For more &8 HOPE [ DAY
e i - HFTD.ORG/FIND-HELP IT’S OK NOT TO BE 0K




YOU HAVE THE POWER TO
CHANGE THE STATISTICS.

START THE
CONVERSATION.

Be supportive. You have the
power to save a life. You have
the power to help someone
flourish and grow. You can do
this just by listening, being
non-judgemental,
informing others on
resources they can use in
case of suicidal thoughts
or attempts, and just being
a support system for
someone in your life.

Hope for the Day offers a wide
variety of initiatives to break the
silence and the stigma surrounding
mental health in your community.
Educate yourself and your community

by taking « Mental Health

First Aid course, donate to our
organization (100% of proceeds go
to our mental health awareness and
education initiatives), or volunteer
with us. There are many opportunities
to change the way the world views
mental illness, and you can be a part
of it.

0

00-273-8255(TALK)1-800-273-88

'8 HOPE i DAY

IT’S OK NOT TO BE OK

B0273-8255(TALKT ™
00-273-8255(TALK) 1-800-273-8
0-273-8255(TALK) 1-800-273-8255(TAl
3-8255(TALK) 1-800-273-8255(TALK) 1-80
255(TALK) 1-800-273-8255(TALK) 1-800-27
[ALK)1-800-273-8255(TALK) 1-800-273-82
800-273-8255(TALK) 1-800-273-8255(
i2.8255(TALK) 1-800-273-8255(TA

By becoming an Agent of

Impact, you will have the power
to change the way others view
mental health in your community.
We'll give you resources and
opportunities to educate others and
become a leader of proactive
suicide prevention.

If you are a business, organization,
or community, you can become a
Partner in Prevention,
which will allow you to work with
Hope for the Day to be proactive in
starting the conversation on mental
health and taking action to be
proactive when it comes to

suicide prevention.

HFTD.ORG/INVOLVED




In the United States alone, more than
40,000 people are lost to suicide each
year, making it the 10th leading cause of
death. Over 1.3 million people attempt

suicide each year.

YOU HAVE
HE POWER TO

SAVE A LIFE.

For signs someone needs help, visit
hftd.org. If you sense something is
wrong, don’t wait. Reach out and
help those you love. You can make
a difference by doing something as

small as just listening.

HFTD.ORG/GETEDUCATED




44 million people suffer from mental illness
each year, However, only half of Americans
experiencing a major depressive episode
seek treatment.

HAVE HOPE.
YOUR STORY

ISN'T OVER YET.

IF you or someone you knowis suffering,
please reach out to these

emergency resources:

The National Suicide Prevention Lifeline:
1-800-273-825

Crisis Text Line:
TEXT “ITSOK” TO 741741

For more national and international

resources, visit hftd.org

HFTD.ORG/FIND-HELP o) OP|




Only 19% of people surveyed believe they

are thoroughly informed on mental illness,

and only 5% claim to be very comfortable
discussing mentalillness:

START
THE

ONVERSATION.

Visithftd.org for ways to get
involved and break the stigma
surrounding mental illness. You have
the power to change the way
mental health is perceived through

a variety of initiatives.

HFTD.ORG/INVOLVED




Final Design

76 million Americans with mental illnesses
fear that they will be discriminated against
and lose the opportunity for jobs, family,
and a happy, normal lifestyle.

START THE

CONVERSATION

Visit hftd.org for ways to get involved and break the
stigma surrounding mental illness. You have the power to
change the way mental health is perceived through a
variety of initiatives. Partner with us as an individual, a
business, or another organization.

If you or someone you know is struggling, call 1-800-273-825 or
text “ITSOK” to 741741

HFTD.ORG/INVOLVED




44 million people suffer from mental
illness each year..However, only half of
Americans experiencing a major depressive
episode actually seek treatment.

HAVE HOPE
YOUR STORY

ISN'T OVER YET

Help is never out of reach. Reach out to a mental health

professional if you or someone you know is suffering. In

emergency situations, contact one of the 24/7 resources

available on hftd.org. Healing is possible. Have hope.
It’s ok not to be ok.

If you or someone you know is struggling, call 1-800-273-825 or
text “ITSOK” to 741741

HFTD.ORG/FIND-HELP




In the United States alone, more than
people are lost to suicide each
year, and over people attempt
suicide ‘each year.

YOU HAVE
THE POWER TO

For signs someone needs help, visit hftd.org. If you sense

something is wrong, don’t wait. Reach out and help those

you love. You can make a difference by doing something

as small as just listening and finding resources. You have
the power to save lives.

If you or someone you know is struggling, call 1-800-273-825 or
text “ITSOK” to 741741

HFTD.ORG/GETEDUCATED




Infographic

Software: Adobe lllustrator
Size: 30 x 60 in

Create an infographic detailing rape & sexual assault statistics to raise
awareness for the subject on our campus and beyond.

Rape and sexual assault is a topic that is largely ignored, especially on
college campuses like MVNU. This 30 x 60 inch infographic illustrates
just how big of a problem sexual assault is, especially among those
of college age. Simple graphs and illustrations are utilized to exhibit
different statistics surrounding assault. A contrasting color scheme

of both light and dark cool-toned colors is non-intimidating to look
at, while still addressing the severity of the issue with the deep blue
and green. Information is easily distinguishable through headings
separating each category of information. The infographic remains
eye-catching and makes the viewer stick with it despite the difficult
subject matter.




Research

MILITARY MAKEUP, 2012 BY GENDER*

1,427,490

total members of the armed services

#539,191- Army  =332,786 - Air Force
317,054 - Navy  #196,024 - Marines
#42,435 - Coast Guard

SEXUAL VIOLENCE IN THE MILITARY

UNWANTED SERVICE MEMBERS WHO EXPERIENCED
SEXUAL CONTACT OTHER FORMS OF SEXUAL VIOLENCE

26,000 1% &

ESTIMATED VICTIMS

23% 20% 23%
. . . 8
4% 5% .
- = Y

Sexual  Crude/offensive  Unwanted Sexist
14,000 12,000 harassme behavior ~ sexual

attention behaviors.

PROSECUTION RATES REPORTING STATISTICS
Of the 1,714 cases that qualified
for possible disciplinary action:

Went to
military
courts

“Data from 2010, See revrse sicefor
RC.

SEXUAL ASSAULT AWARENESS

HE WORLD [ Sy

have experienced

SEXUAL ASSAULT

SEXUALLY *

NIWOM

ASSAULTED

321,500 O o
AVERAGE #'OF VICTIMS UNREPORTED:;}
EVERY YEAR IN THE U.S. @ TO POLICE:

UNDERGRAD @ 54% 28% 15%

WOMEN
R AGE OF VICTIMS

§5 ASSAULTED in the usa

e

ob

|enxas jo

WE’'RE WORKING EVERY DAY TO CHANGE THIS REALITY
BY MAKING SAFETY TECHNOLOGY ACCESSIBLE TO ALL

YREVOLAR B O G

SOURCES: Carr Do, an e P "o o o AL Camun CmateSrvey o S Avst and Sl Macomuct* Wesa 2015 g, AL Wets




Roughs

SEXUAL ASSAULT VICTIMIZATIONS

VICTIM

Gender Age Race
- s .
W s & s
NON
STUDENTS STUDENTS

$ o
Region

3,544 2,333

et s
ot cog e s e 1217, 251
ey S 0 oo 4.3 000
g s

=, &, *

%
3

“ﬁan&j %m—m‘i

RURAL  SUBURBAN URBAN

46PER1000  GOPER1,000 66 PER1000

(student) (student) student
BBPER1000  63PER1,000 87 PER1000
(non-student) (non-student)

SEERAT,  MNEREERT  oesmen o omsten e s s
Emm S T e iy v e

Relationship to Victim Gender o

§= w'lﬂf

It

Race Age Substance

5OET

ATTAS

we /7 Locatmn

o :’

-

= = =
Activity
Chrrerm  cmr  Cowers
e =
e =
e = ==
e = =
E— - -

Injuries & Treatment

‘ STUDENTS ‘ s“',':(",'m STUDENTS,

REPORTING

]
Victimizations

[—
R s o
PURR  pen—.
[T ee——
apr
Reason for nat reporting Students. Non-Students

Time of Day
/\ WF N\ e
= o et
82 3 studonis and 54% o1
N Y o) A
. 2 \ ot

 ’
Violent Crime

Sudeiion-tten s

A woagon vas s i
1% of student assaus,and
12% i ronstudent ssats

NON-
STUDENTS
I you or someone you know has been
affected by rape, sexual assault or intimate.
partner violence on your
reach out o your Tile X director.




KNOW THE FACTS, BREAK THE CYCLE

Rape & Sexual Assault Victimizations

Among college-age adults, 1995-2013
Information gathered by the U.S. Department of Justice

REPORTIN B
-

OF Fear of reprisal 20% 20%
STUDENT ASSAULTS Notmportan 126 5% .
Didn't want 1in5
AND OF T i 10w
NON-STUDENT i hen e 1o

FEAR OF REPRISAL

Yo OF STUDENTS
SUSTAIN INJURIES

63% OF NON-STUDENTS
SUSTAIN INJURIES

ASSAULTS ARE

Type of Attack and 6 AM.
1% 8%

47% 40%
won
swons | smoots
Perceived the
offender is under the
influence of DRUGS
@ Completed Rape @ Sexual Assault or ALCOHOL.
Attempted Rape @ Threat of Rape

over ofassautts  Over B0% o vctims do not
Q DO NOT involve a weapon  €Ceive treatment for their injuries

The MIDWEST Rural - Suburban Urban
has the highest

rate of rape 50% of
in the country. NON-STUDENT
38% of STUDENT
8.8

cur
AT/NEAR
rxiom 6.3 8.7 THE VICTIM'S

st HOME

year olds are at W

highest risk
of sexual assault

100% o 0% o
MALE
DO NOT receive assistance from a victim

service agency following their assault.
RATE OF RAPE
NON-STUDENTS [ERGEZ A 0
STUDENTS | 6.1 PER 1,000 * “ @

collaboration between MVNu’s criminal justice .
& art and design department 8 In 10
MOUNT@VERNON
NAZARENE UNIVERSITY

SPONSORED BY > pvcomm

21-29
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KNOW THE FACTS, BREAK THE CYCLE

Rape & Sexual Assault Victimizations
Among college-age adults, 1995-2013

Information gathered by the U.S. Department of Justice

REPORTING Rt ot o @

UNLY OF Personal Matter ~ 26% 23%
Fear of reprisal 20%  20%
ASSAULTS AND 1in5
offender to get
ASSAULTS T FEAR OF REPRISAL

ARE REPORTED

and 6 A.M.
7:vpe of Attack

57% OF STUDENTS
SUSTAIN INJURIES

63% OF NON-STUDENTS

47% 40% SUSTAIN INJURIES
sons sriotns
Perceived the
offender is under
the influence of
DRUGS or ALCOHOL.
@ Completed Rape @ Sexual Assault
Attempted Rape () Threat of Rape over of assaults Over 60% of victims do not
DO NOT involve a weapon receive treatment for
o ‘their injuries

Rural  Suburban Urban
The MIDWEST

has the highest 50% o
raleho' vape‘ ! NON-STUDENT
in the country: %
38% of STUDENT
attacks occu
AT/NEAR
.8 K 7] THE VICTIM'S
PERIGD  PERIO0  peRico0 HOME

Cvicrivs RN  OFFENDERS

100%
year olds are at MALE .

highest risk
of sexual assault

over 50% of

offenders are

21-29

RATE OF RAPE
NON-STUDENTS

STUDENTS 6.1 PER 1,000 * 4 * * 4
Y

82% X3

DO NOT receive assistance from a victim 8in 10

service agency following their assault

Criminal Justice, Art & Design Dept., IX office
ou kno 1, Sponsored by PVCC

| 800-656-HOPE




